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Chapter 2
BIM and Autodesk Revit Architecture

In this chapter you learn about Building Information Modeling (BIM) and how it is 
used in the Autodesk® Revit® Architecture software. You investigate the software 
interface and terminology, learn how to start projects, and work with the viewing 
commands including zoom controls, 3D isometric, and perspective views.

This chapter contains the following topics:

�Building Information Modeling
�Overview of the Interface
�Standard Terminology
�Starting Projects
�Viewing Commands
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Learning Objectives
This chapter provides instruction to enable you to do the 
following:

2.1 Building Information Modeling
Understand the concept of Building Information Modeling 
and its workflow in relation to the Autodesk Revit software.

2.2 Overview of the Interface
Navigate the graphic user interface.

2.3 Standard Terminology
Use typical terms and concepts found in the software.

2.4 Starting Projects
Start new projects using templates.

2.5 Viewing Commands
Manipulate 2D and 3D views by zooming and panning.

Create 3D Isometric and Perspective views.

Set the Visual Style of a view.
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2.1 Building Information 
Modeling

Building Information Modeling (BIM) is an approach to the entire 
building life cycle. The BIM process supports the ability to 
coordinate, update, and share design data with team members 
throughout the design, construction, and management phases of 
a building’s life.

The Autodesk Revit software is a Parametric Building Modeler, 
and is an important part of the BIM process. Parametric means 
you can establish a relationship between two building elements; 
when one element changes the other element changes as well. 
Building signifies that this software is designed for working with 
buildings, as opposed to gears or roads. Modeler signifies how a 
project is built in a single file around the building model (as 
shown on the left in Figure 2–1). All views, such as plans (as 
shown on the right in Figure 2–1), elevations, sections, details, 
schedules, as well as all design sheets printed for construction 
documents, are automatically generated based on the model.

When a change is made 
anywhere in the model, 
all of the views update 
automatically. For 
example, if you add an 
element in a plan view, it 
displays in the related 
section view and in 
schedules (if 
applicable).

Figure 2–1

� The Autodesk Revit Architecture software coordinates with 
two other software packages: Autodesk® Revit® MEP 
(Mechanical, Electrical, and Plumbing) and Autodesk® Revit® 
Structure. It also enables you to check for interferences 
between disciplines.

Understand the concept of Building Information Modeling 
and its workflow in relation to the Autodesk Revit software.
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Workflow
and BIM

BIM has changed the process of how a building is designed. The 
Autodesk Revit software is a true BIM product in that it is much 
more than a drafting software. By creating complete models and 
associated views of those models, the software takes much of 
the tediousness out of producing a building design.

In the traditional design process, plans create the basis for the 
model, from which you then create sections and elevations, as 
shown in Figure 2–2. Construction Documents (CDs) can then 
be created. In this workflow, changes are made at the plan level 
and then coordinated with other documents in the set.

Figure 2–2

In the BIM, the design process revolves around the model, as 
shown in Figure 2–3. Plans, elevations, and sections are simply 
2D versions of the 3D model. Changes made in one view 
automatically update in all views. Even Construction Documents 
update automatically with callout tags in sync with the sheet 
numbers. This is called bidirectional associativity.

The elements that you 
create in the software 
are smart elements that 
know they are walls, 
windows, doors, or 
stairs. Because they are 
smart elements, they 
display properly in plan, 
elevation, or 3D views. 
This ensures that 
drawings are 
coordinated across the 
project because the 
same model generates 
all of the necessary 
views. Figure 2–3
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Views and
Sheets

In the traditional workflow, the most time-consuming part of the 
project is the construction documents. With BIM, the base views 
of those documents (i.e., floor plans, ceiling plans, elevations, 
sections, and schedules) are produced automatically and update 
as the model is updated, saving hours of work. The views are 
then placed on sheets that make up the construction document 
set.

For example, to create a Life Safety Plan, a floor plan is created 
from the model and then duplicated to create the Life Safety 
Plan. In the new view, certain categories of elements are turned 
off (such as grids and section marks), while furniture elements 
are set to halftone. Annotation is added in regard to exits and 
room classifications. The plan is then placed on a sheet, as 
shown in Figure 2–4.

Figure 2–4

� Work can continue on a view and is automatically updated on 
the sheet.
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2.2 Overview of the Interface

The Autodesk Revit interface is designed for intuitive and 
efficient access to commands and views. It includes the Ribbon, 
Quick Access Toolbar, Application Menu, and Status Bar, which 
are common to the newer versions of all Autodesk® software. It 
also includes tools that are specific to the Autodesk Revit 
software, including the Properties palette, Project Browser and 
View Control Bar. The interface is shown in Figure 2–5.

Figure 2–5

Navigate the graphic user interface.
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1. Quick Access Toolbar 2. InfoCenter

3. Application Menu 4. Ribbon

5. Options Bar 6. Properties Palette

7. Project Browser 8. Drawing Area

9. View Control Bar ��10.Status Bar
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1. Quick Access Toolbar

The Quick Access Toolbar provides access to commonly used 
commands, such as Open, Save, Undo and Redo, Dimension, 
and 3D View, as shown in Figure 2–6.

Figure 2–6

� The Quick Access Toolbar is easily customizable. Select the 
arrow at the end of the toolbar. You can choose from the list 
of commands or click Customize Quick Access Toolbar to 
bring up a dialog box where you can modify the location of 
the tools on the toolbar as shown in Figure 2–7.

Figure 2–7

� You can also customize it by adding commands from any of 
the Ribbon tabs. Right-click on the command in the Ribbon 
and select Add to Quick Access Toolbar as shown in 
Figure 2–8.

Figure 2–8
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2. InfoCenter

The InfoCenter enables you to quickly search for help on the 
web, as shown in Figure 2–9. You can specify which Help 
documents to search and collapse or expand the Search field to 
save screen space. You can also sign into Autodesk Online to 
access additional services and use the Autodesk Exchange 
Apps website.

You can collapse or 
expand the Search field 
to save screen space. Figure 2–9

3. Application Menu

The Application Menu provides access to file commands, 
settings, and documents, as shown in Figure 2–10. Hover the 
cursor over a command to display a list of additional tools.

If you click the primary 
icon rather than the 
arrow, it starts the 
default command.

Figure 2–10
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� At the bottom of the menu, click  to open the Options 

dialog box or click  to exit the program.

Recent Drawings

To display a list of recently used documents click  (Recent 
Documents) in the Application menu. The documents can be 
reordered as shown in Figure 2–11. 

Figure 2–11

� Click  (Pin) next to a document name to keep it available, 
even if more documents are opened than can be displayed. It 

displays with the push pin tacked in ( ).

Open Drawings
To display a list of open documents and views, click 

 (Open Documents). The list displays the open documents 
and each view that is open, as shown in Figure 2–12.

You can use the Open 
Documents list to 
change between views.

Figure 2–12

� Click  (Close) to close the current project.
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� When you expand  (Open) there is a new option 

(  (Sample Files)) that takes you to a folder containing the 
sample files supplied with the software.

4. Ribbon

The Ribbon contains tools in a series of tabs and panels as 
shown in Figure 2–13. Selecting a tab displays a group of related 
panels. The panels contain a variety of tools, grouped by 
function.

Figure 2–13

When you start a command that creates new elements or you 
select an element, the Ribbon displays the Modify | contextual 
tab. This contains general editing commands and command 
specific tools at the end of the tab, as shown in Figure 2–14.

Figure 2–14

� When you hover over a tool on the Ribbon, tooltips display 
the tool’s name and a short description. If you continue 
hovering over the tool a graphic displays (and sometimes a 
video) as shown in Figure 2–15.

Figure 2–15
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� Many commands have shortcut keys. For example, type AL 
for Align or MV for Move. They are listed next to the name of 
the command in the tooltips. Do not press <Enter> to execute 
shortcuts.

� The order in which the Ribbon tabs are displayed can be 
modified. Select the tab, hold down <Ctrl>, and drag it to a 
new location. The location is remembered when you restart 
the program.

� Any panel can be dragged by its title into the drawing area to 
become a floating panel. Click the Return Panels to Ribbon 
button as shown in Figure 2–16 to replace the panel.

Figure 2–16

Hint: You are always in a command when using the 
Autodesk Revit software.

When you are finished working with a tool, you typically default 
back to the Modify command. To end a command, use one of 
the following methods: 

� In any Ribbon tab, click  (Modify).
� Press <Esc> once or twice to revert to Modify.
� Right-click and select Cancel...
� Start another command.
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5. Options Bar

The Options Bar displays options that are related to the selected 
command or element. For example, when the Rotate command 
is active it displays options for rotating the selected elements, as 
shown at the top of Figure 2–17. When the Place Dimensions 
command is active it displays dimension related options, as 
shown at the bottom of Figure 2–17.

Figure 2–17

6. Properties Palette

In the Properties palette you can make extensive modifications 
to views and elements. If nothing is selected and you are not in a 
command, the Properties palette displays options for the current 
view, as shown on the left in Figure 2–18. If a command or 
element is selected, it displays options for the associated 
element, as shown on the right in Figure 2–18.

Figure 2–18

� Items that are grayed out are read-only.
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� The Properties palette is usually kept open while working on 
a project to easily permit modifications at any time. It can be 
placed on a second monitor as well as floated and resized.

� If the Properties palette does not display, click

 (Properties) in the Modify tab>Properties panel, or type 
PP. 

� When multiple elements are selected, you can filter the 
elements selected in the Properties palette using the 
drop-down list, as shown in Figure 2–19.

Figure 2–19

� When you start a command or select an element, you can set 
the element type in the Type Selector as shown in 
Figure 2–20.

Right-click on the Type 
Selector to add it to the 
Quick Access Toolbar 
and/or to the Ribbon 
Modify tab.

Figure 2–20
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Hint: Type Properties

Type Properties are parameters that are common to all of the 
elements in a specific family. When a single type of element is 

selected, click  (Edit Type) in Properties to open the Type 
Properties dialog box, as shown in Figure 2–21.

Figure 2–21
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7. Project Browser

The Project Browser lists the views that can be opened in the 
software as shown in Figure 2–22. This includes all views of the 
model in which you are working and any additional views that 
you create, such as floor plans, ceiling plans, 3D views, 
elevations, sections, etc. It also includes views of schedules, 
legends, sheets (for plotting), families (such as doors and walls), 
groups, and Revit Links.

The Project Browser 
displays the name of the 
active project.

Figure 2–22

� Double-click on an item in the list to open the associated 
view.

� To display the views associated with a view type, click

 (Expand) next to the section name. To hide the views in 

the section, click  (Contract).

� Right-click on a view and select Rename or press <F2> to 
rename a view in the Project Browser.

� If you no longer need a view, you can remove it. Right-click 
on its name in the Project Browser and select Delete.

� The Project Browser can be floated, resized, and customized.
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How to: Search the Project Browser
1. In the Project Browser, right-click on the top level Views node 

as shown in Figure 2–23.

Figure 2–23

2. In the Search in Project Browser dialog box, type the words 
that you want to find (as shown on the left in Figure 2–24), 

and click .
3. In the Project Browser, the first instance of that search 

displays as shown on the right in Figure 2–24.

Figure 2–24

4. Continue using  and  to move through 
the list.

5. Click  when you are done.
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8. Drawing Area

Each view of a project opens in its own window, as shown in 
Figure 2–25. Each view displays a Navigation Bar (for quick 
access to viewing tools) and the View Control Bar.

In 3D views you can 
also use the ViewCube 
to rotate the view.

Figure 2–25

� Each view of a project opens in its own window. You can use 
the Project Browser or press <Ctrl>+<Tab> to cycle through 
the open views.

� If you have multiple views open you can select a view by 
name. In the Quick Access Toolbar or View tab>Windows 

panel, expand  (Switch Windows) and select from the list.

� If you have more than one view open, click  (Cascade) or 

 (Tile) in the View tab>Windows panel to arrange them in 
the selected order on the screen. You can also use the 
shortcut keys WC for Cascade and WT for Tile.

Navigation Bar

View Control Bar
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9. View Control Bar

The View Control Bar (shown in Figure 2–26), displays at the 
bottom of each view window. It controls aspects of that view, 
such as the scale and detail level. It also includes tools that 
display parts of the view and hide or isolate elements in the view.

Figure 2–26

10. Status Bar

The Status Bar provides information about the current process, 
such as the next step for a command, as shown in Figure 2–27.

Figure 2–27

� Other options in the Status Bar are related to Worksets and 
Design Options (advanced tools) as well as selection 
methods and filters.

Hint: Right-click Menus

Right-click menus help you to work smoothly and efficiently by 
enabling you to quickly access the required commands. These 
menus always provide access to basic viewing commands as 
well as recently used commands, as shown in Figure 2–28. The 
other options vary depending on the selected element or 
command that you are using.

Figure 2–28
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2.3 Standard Terminology

As you start working with BIM based software, you should know 
the typical terms used to describe items in the Autodesk Revit 
software. There are several types of elements, as shown in 
Figure 2–29, and described in the following table.

Figure 2–29

Use typical terms and concepts found in the software.

Certification
Topic:
�Elements
Objectives:
�Modify an element's type 

parameters

Host

Hosted 
Component

Datum

Annotation

Stand-alone 
Component

Elevation View

Host Built-in-place construction elements (such as floors, 
walls, roofs, ceilings, stairs, and ramps). They can stand 
alone in the project.

Components Elements that need to be attached to host elements (such 
as doors, windows, and railings), as well as stand-alone 
items (such as furniture and equipment).

Views Enables you to display and manipulate the project. For 
example, you can view and work in floor plans, ceiling 
plans, elevations, sections, schedules, and 3D views. 
You can change a design from any view. All views are 
stored in the project.

Datum Elements that define the project context. These include 
levels for the floors, column grids, and reference planes 
that help you draw.

Annotation 2D elements that are placed in views to define the 
information drawn in the project. These include 
dimensions, text, tags, and symbols. The view scale 
controls their size.
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Property Types

There are two types of properties for most elements in the 
software:

� Instance Properties: Parameters that can be set for the 
individual element you are drawing or modifying. They 
display in the Properties palette.

� Type Properties: Control options for all elements of the 
same type. If you modify these parameters, all elements of 
the selected type change.

Instance properties display in the Properties palette, and can be 
toggled on/off in the Modify tab>Properties panel (as shown in 
Figure 2–30) or by typing the shortcut PP.

Figure 2–30

� To display the type properties, click  (Edit Type) in 
Properties to open the Type Properties dialog box, as shown 
in Figure 2–31. Any changes you make in the Type 
Properties dialog box impact all instances of the type in the 
project.

The parameters shown 
in the dialog boxes vary 
according to the type of 
element selected.

Figure 2–31��

Type Properties

Properties 
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2.4 Starting Projects

File operations to open existing files, create new files from a 
template, and save files in the Autodesk Revit software follow 
standard Windows procedures, as shown in the Open dialog box 
in Figure 2–32.

Figure 2–32

There are three main file types: 

� Project files (.rvt): Your primary drawing files. This is where 
you do the majority of your work in the building model with 
views and sheets. They are initially based on template files.

� Family files (.rfa): Separate components that can be 
inserted in a project. For example, the Single Flush and 
Double Glass door families include a variety of door sizes, 
and the Desk family includes a number of desk sizes and 
styles. Title block and Annotation Symbol files are special 
types of family files.

� Template files (.rte): Designed to hold standard information 
and settings for creating new project files. The software 
includes several templates for residential, commercial, and 
structural projects. You can also create custom templates.

Start new projects using templates.

Certification
Topic:
�Elements
Objectives:
�Use Revit family templates
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When you first open the Autodesk Revit software, the Startup 
Screen displays, showing lists of recently used project and family 
files. This screen also displays if you close all projects.

Starting
New Projects

New projects are based on a template file. The template file 
includes preset levels, views, and some families, such as wall 
styles and text styles. Check with your BIM Manager about which 
template you need to use for your projects. Your company might 
have more than one based on the types of building you are 
designing.

How to: Start a New Project

1. In the Application Menu, expand  (New) and click 

 (Project), as shown in Figure 2–34.

Figure 2–34

Hint: Opening Workset-Related Files
Worksets are used when the project becomes large enough for 
multiple people to work on it at the same time. At this point, the 
project manager creates a central file with multiple worksets 
(such as element interiors, building shell, and site) that are 
used by the project team members.

When you open a workset related file it creates a new local file 
on your computer as shown in Figure 2–33. Do not work in the 
main central file.

Figure 2–33
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2. In the New Project dialog box (shown in Figure 2–35), select 

the template that you want to use and click .

The list of Template files is 
set in the Options dialog 
box in the File Locations 
pane. It might vary 
depending on the installed 
product and company 
standards.

Figure 2–35

� You can select from a list of templates if they have been set 
up by your BIM Manager.

� You can add  (New) to the Quick Access Toolbar. At the 

end of the Quick Access Toolbar, click  (Customize Quick 
Access Toolbar) and select New, as shown in Figure 2–36.

Figure 2–36

Saving Projects Saving your project frequently is a good idea. Click  (Save) in 
the Quick Access Toolbar to do this at any time. If the project has 
not yet been saved, the Save As dialog box opens, where you 
can specify a file location and name.

� To save an existing project with a new name, in the 

Application Menu, expand  (Save As) and click 

 (Project). 
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� If you have not saved in a set amount of time, the software 
opens the Project Not Saved Recently alert box, as shown in 
Figure 2–37. Select Save the project. If you want to set 
reminder intervals or not save at this time, select the other 
options.

Figure 2–37

� You can set the Save Reminder interval to 15 or 30 minutes, 
1, 2, or 4 hours, or to have No reminders display. In the 

Application Menu, click  to open the Options dialog 
box. In the left pane, select General and set the interval as 
shown in Figure 2–38.

Figure 2–38

Saving Backup Copies

By default, the software saves a backup copy of a project file 
when you save the project. Backup copies are numbered 
incrementally (e.g., My Project.0001.rvt, My Project.0002.rvt, 
etc.) and are saved in the same folder as the original file. In the 

Save As dialog box, click  to control how many 
backup copies are saved. The default number is three backups. 
If you exceed this number, the software deletes the oldest 
backup file.
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Hint: Saving Workset-Related Projects

If you use worksets in your project, save locally and to the 
central file. Save the local file frequently just like any other file. 

Then, every hour or so, click  (Synchronize Now) in the 
Quick Access Toolbar to save your changes back to the main 
file. After you save to central, save the local file again.

If you use  (Synchronize with Central), you can specify that 
the local file is saved before or after the synchronization.
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2.5 Viewing Commands

Zoom commands are crucial to working efficiently in most 
drawing programs and the Autodesk Revit software is no 
exception. Once in a view, you can use the Zoom controls to 
navigate within it. You can zoom in and out and pan in any view. 
There are also special tools for viewing in 3D.

Zooming and
Panning

Using Your Mouse to Zoom and Pan

Use your mouse wheel (as shown in Figure 2–39) as the main 
method of moving around the drawing.

Figure 2–39

� Scroll the wheel on the mouse up to zoom in and down to 
zoom out.

� Hold down the wheel and move the mouse to pan.

� Double-click on the wheel to zoom to the extents of the 
drawing.

� In a 3D view, hold down <Shift> and the mouse wheel and 
move the mouse to rotate around the model.

Manipulate 2D and 3D views by zooming and panning.

Create 3D Isometric and Perspective views.

Set the Visual Style of a view.

Mouse 
Wheel
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Zoom Controls

A number of additional zoom methods enable you to control the 
screen display. Zoom and Pan can be performed at any time 
while using other commands.

� You can access the Zoom commands in the Navigation Bar 
in the upper right corner of the view (as shown in 
Figure 2–40). You can also access them from most right-click 
menus and by typing the shortcut commands.

 (2D Wheel) 
provides cursor-specific 
access to Zoom and 
Pan.

Figure 2–40

Zoom Commands

Zoom In Region 
(ZR)

Zooms into a region that you define. Drag the 
cursor or select two points to define the 
rectangular area you want to zoom into. This is 
the default command.

Zoom Out(2x) 
(ZO)

Zooms out to half the current magnification 
around the center of the elements.

Zoom To Fit 
(ZF or ZE)

Zooms out so that the entire contents of the 
project only display on the screen in the current 
view.

Zoom All To Fit 
(ZA)

Zooms out so that the entire contents of the 
project display on the screen in all open views.

Zoom Sheet 
Size (ZS)

Zooms in or out in relation to the sheet size.

Previous 
Pan/Zoom (ZP)

Steps back one Zoom command.

Next Pan/Zoom Steps forward one Zoom command if you have 
done a Previous Pan/Zoom.
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Viewing in 3D Even if you started a project entirely in plan views, you can 
quickly create 3D views of the model, as shown in Figure 2–41.

There are two types of 
3D views: isometric 
views created by the 3D 
View command and 
perspective views 
created by the Camera 
command.

Figure 2–41

Working in 3D views helps you visualize the project and position 
some of the elements correctly. You can create and modify 
elements in 3D views just as in plan views. 

� Once you have created a 3D view, you can save it and easily 
return to it. 

How to: Create and Save a 3D Isometric View

1. In the Quick Access Toolbar, click  (Default 3D View).The 
default 3D Southeast isometric view opens, as shown in 
Figure 2–42. 

You can spin the view to 
a different angle using 
the mouse wheel or the 
middle button of a 
three-button mouse. 
Hold down <Shift> as 
you press the wheel or 
middle button and drag 
the cursor.

Figure 2–42

2. Modify the view to display the building from other directions. 
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3. In the Project Browser, right-click on the {3D} view and select 
Rename...

You can also rename 
perspective views.

4. Type a new name in the Rename View dialog box, as shown 

in Figure 2–43, and click .

Figure 2–43

� When changes to the default 3D view are saved and you start 
another default 3D view, it displays the Southeast isometric 
view once again. If you modified the default 3D view but did 
not save it to a new name, the Default 3D View command 
opens the view in the last orientation you specified.

How to: Create a Perspective View
1. Switch to a Floor Plan view.
2. In the Quick Access Toolbar or View tab>Create panel, 

expand  (Default 3D View) and click  (Camera).
3. Place the camera on the view.
4. Point the camera in the direction in which you want it to shoot 

by placing the target on the view, as shown in Figure 2–44.

Figure 2–44
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A new view is displayed, as shown in Figure 2–45.

Use the round controls 
to modify the display 
size of the view and 
press <Shift> + the 
mouse wheel to change 
the view.

Figure 2–45

Visual Styles Any view can have a visual style applied. The Visual Style 
options found in the View Control Bar (shown in Figure 2–46), 
specify the shading of the building model. These options apply to 
plan, elevation, section, and 3D views.

Figure 2–46

The Shaded and Consistent Colors visual styles give you a 
sense of the materials, including transparent glass, as shown in 
Figure 2–47.

Figure 2–47



Autodesk Revit Architecture 2013 Fundamentals

2–32���������������������������������������������������������������������������������������������������������������������������������������������������������	
�����

� The Realistic visual style displays what is displayed when 
you render the view. It takes a lot of computer power to 
execute this visual style; therefore, it is better to use the other 
visual styles most of the time as you are working.

� The Ray Trace visual style is useful if you have created a 3D 
view that you want to render. It gradually moves from draft 
resolution to photorealistic. You can stop the process at any 
time.

Hint: Using the ViewCube

The ViewCube provides visual clues as to where you are in a 
3D view. It helps you move around the model with quick access 
to specific views (such as top, front, and right), as well as 
corner and directional views, as shown in Figure 2–48.

Figure 2–48

Move the cursor over any face of the ViewCube to highlight it. 
Once a face is highlighted, you can select it to reorient the 
model. You can also click and drag on the ViewCube to rotate 
the box, which rotates the model.

�  (Home) displays when you roll your cursor over the 
ViewCube. Click it to return to the view defined as Home. To 
change the Home view, set the view as you want it, 
right-click on the ViewCube, and select Set Current View 
as Home.

� The ViewCube is available in isometric and perspective 
views.
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Practice 2a Open and Review a Project

Estimated time for 
completion: 15 minutes

In this practice you will open a project file and view each of the 
various areas in the interface. You will investigate elements, 
commands, and their options. You will also open views through 
the Project Browser and view the model in 3D, as shown in 
Figure 2–49.

Figure 2–49

Task 1 - Explore the interface.

1. Open the project file Modern-Hotel-Final.rvt. It is found in 
your class directory and is a version of the main project you 
will work on throughout the course.

2. Take time to review the floor plan to get acquainted with it.

Navigate the graphic user interface.

Manipulate 2D and 3D views by zooming and panning.

Create 3D Isometric and Perspective views.

Set the Visual Style of a view.
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3. Review the various parts of the screen.

4. In the drawing window, hover your cursor over one of the 
doors. A tooltip displays describing the element, as shown in 
Figure 2–50.

Figure 2–50

5. Hover the cursor over another element to display its 
description.

6. Select a door. The Ribbon changes to the Modify | Doors tab.

7. Click in an empty space to release the selection set.

8. Hold down <Ctrl> and select several elements of different 
types. The Ribbon changes to the Modify | Multi-Select tab.

9. Click in an empty space to release the selection set.

10. In the Home tab>Build panel, click  (Wall). The Ribbon 
changes to the Modify | Place Wall tab and displays specific 
tools you can use to create walls at the end of the Ribbon tab. 
The rest of the Ribbon displays the same tools that are found 
on the Modify tab.

11. In the Select panel, click  (Modify) to return to the main 
Ribbon.

12. In the Home tab>Build panel, click  (Door). The Ribbon 
changes to the Modify | Place Door tab and displays the 
options and tools you can use to create doors.
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Task 2 - Look at views.

You might need to 
widen the Project 
Browser to display1 the 
full names of the views.

1. In the Project Browser, expand the Floor Plans node. 
Double-click on the 1st Floor Furniture Plan view.

2. The basic floor plan displays with the furniture but none of the 
annotations you saw in the other view. Open the 1st Floor 
Life Safety Plan view.

3. The walls and furniture display, but the furniture is grayed out 
and red lines describing important life safety information 
display.

4. In the Project Browser, scroll down and expand Elevations 
(Building Elevation). Double-click on the East elevation to 
open the view.

5. Expand Sections (Building Section) and double-click on the 
East-West Building Section to open it.

6. In the View Control Bar, click  (Visual Style) and select 
Shaded. The elements in the section are now easier to read.

7. In the Project Browser, scroll down to the Sheets (all) node.

8. View several of the sheets. Some have views already 
applied, such as the A4.1 Reflected Ceiling Plan shown in 
Figure 2–51.

Figure 2–51

9. Which sheet shows the view that you just set to Shaded?
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Task 3 - Practice viewing tools.

1. Return to the Floor Plans: 1st Floor view.

2. In the Navigation Bar, click  and select Zoom In Region 
or type ZR at the Command Line. Zoom in on one of the 
stairs.

3. Pan to another part of the building using the middle mouse 
button or wheel. Alternatively, you can use the 2D Wheel in 
the Navigation Bar.

4. Double-click on the mouse wheel to zoom out to fit the 
extents of the view.

5. In the Quick Access Toolbar, click  (3D View) to open the 
default 3D view, as shown in Figure 2–52.

Figure 2–52

6. Hold down <Shift> and use the middle mouse button or wheel 
to rotate the view.

7. In the View Control Bar, change the Visual Style to 

 (Shaded). Then try  (Consistent Colors). Which one 
works best when you view the back of the building?

8. Use the ViewCube to find a view that you want to use.

9. In the Project Browser, expand 3D Views and right-click on 
the {3D} view. Rename it.
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10.Look at the two other 3D views that have already been 
created.

11. Return to the Floor Plans: 1st Floor view.

12. In the Quick Access Toolbar, expand  (Default 3D View) 

and click  (Camera).

13.Click the first point near the Lobby room name and click the 
second point outside the building, as shown in Figure 2–53.

Figure 2–53

14.The furniture and planters display even though they did not 
display in the floor plan view. 

This file is not set up to 
work with Raytrace.

15.Set the Visual Style to  (Realistic).

16.Save the view as Lobby Seating Area.

17. In the Quick Access Toolbar, click  (Save) to save the 
project.

18. In the Application Menu, select Close. This closes the entire 
project. 

1st Point 2nd Point
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Chapter Review Questions

1. When you create a project in the Autodesk Revit software, do 
you draw in 2D or 3D?

2. What is the purpose of the Project Browser?

3. Which part of the interface changes according to the 
command you are in?

4. When you start a new project, how do you specify the base 
information in the new file?

5. What is the main difference between  (3D View) and a 
Camera view?
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Command Summary
Button Command Location

3D View � Quick Access Toolbar
� Ribbon: View tab>Create panel

Camera � Ribbon: View tab>Create panel>
3D View>Camera

Consistent 
Colors

� View Control Bar: Visual Style> 
Consistent Colors

Door � Ribbon: Home tab>Build panel
� Shortcut: DR

Hidden Line � View Control Bar: Visual 
Style>Hidden Line

� Shortcut: HL
Home � ViewCube

Modify � Quick Access Toolbar
� Ribbon: <name of contextual> tab>

Select panel
� Shortcut: MD
� Contextual Ribbon

New � Quick Access Toolbar (Optional)
� Application Menu: New>Project
� Shortcut: <Ctrl>+<N>

Next Pan/Zoom � Navigation Bar
� Right-click Menu

Open 
Documents

� Application Menu: Open 
Documents

Previous 
Pan/Zoom

� Navigation Bar
� Shortcut: ZP

Ray Trace � View Control Bar: Visual Style>Ray 
Trace

Realistic � View Control Bar: Visual Style> 
Realistic

Recent 
Documents

� Application Menu: Recent 
Documents

Save � Quick Access Toolbar 
� Application Menu: Save
� Shortcut: <Ctrl>+<S>

Scale � View Control Bar

Synchronize 
Now/ 
Synchronize 
and Modify 
Settings

� Quick Access Toolbar 
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Shaded � View Control Bar: Visual Style> 
Shaded

� Shortcut: SD
Visual Style � View Control Bar

Wall � Ribbon: Home tab>Build panel
� Shortcut: WA

Wireframe � View Control Bar: Visual Style>
Wireframe

� Shortcut: WF
Zoom All to Fit � Navigation Bar

� Shortcut: ZA
Zoom In Region � Navigation Bar

� Shortcut: ZR
Zoom Out 2x � Navigation Bar

� Shortcut: ZO
Zoom Sheet 
Size

� Navigation Bar
� Shortcut: ZS

Zoom to Fit � Navigation Bar
� Shortcut: ZF or ZE


